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QUESTION 1: 
 
Select the correct menu bar sequence to insert a new table into a Word document. 
 
A. Insert, Table, Insert 
B. Format, Table, Insert 
C. Tools, Insert, Table 
D. Table, Insert, Table 
 
Answer: D 
 
Explanation: Tables are inserted into a document by selecting Table, Insert, Table on the 
menu bar. Specify the number of columns and rows in the Insert Table dialog box, and 
click OK. Tables can also be inserted by selecting the Insert Table button on the Standard 
toolbar. 

 
QUESTION 2: 
 
What is the default page number location when inserting page numbering using the Page 
Numbers dialog box? 
 
A. Bottom, Left 
B. Top, Left 
C. Top, Right 
D. Bottom Right 
 
Answer: D 
 
Explanation: Page numbering can be inserted into a document by selecting Insert, Page 
Numbers on the menu bar. When the Page Numbers dialog box displays, the default 
location and alignment are Bottom, Right. 

 
QUESTION 3: 
 
Page orientation is set from this tab in the Page Setup dialog box. 
 
A. Margins 
B. Paper 
C. Layout 
D. Page 
 
Answer: A 
 
Explanation: Portrait and Landscape are the two page orientations that can be applied to a 
word document, and are set from the Margins tab in the Page Setup dialog box. 
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QUESTION 4: 
 
Heading 1, Heading 3, and Normal are examples of _____________. 
 
A. Properties 
B. Styles 
C. Characteristics 
D. Attributes 
 
Answer: B 
 
Explanation: To create, apply, or modify a style, select Format, Styles and Formatting on 
the menu bar. When the task pane displays, select the desired style from the list window or 
select the New Style button to create a new style. When a style is applied to text headings in 
a document, any changes made to the style will reflect throughout the document. 

 
QUESTION 5: 
 
You are spell checking a document and the spell checker stops at a correctly spelled word. 
What option can you select in the Spelling and Grammar dialog box so the spell checker 
places the word in the dictionary? 
 
A. Place in dictionary 
B. Add to dictionary 
C. Place 
D. Add 
 
Answer: B 
 
Explanation: Selecting the Add to Dictionary button adds the word to the dictionary so 
future occurrences of the word will not be picked up unless it is misspelled. Add is a good 
guess but this was used in previous versions of Word. 

 
QUESTION 6: 
 
Which is NOT a type of indenting that is supported in Word? Select all that apply. 
 
A. Last Line 
B. Hanging 
C. Right 
D. Suspending 
 
Answer: A, D 
 
Explanation: Last Line and Suspending indents don't exist. First Line and Hanging are 



MOS-WXP 
 

Actualtests.com - The Power of Knowing 
 

 

special indents. Indenting can be applied from the Formatting toolbar or by clicking 
Format, Paragraph on the menu bar. The indent markers on the ruler can also be used to 
set indents. 

 
QUESTION 7: 
 
Select the correct menu bar sequence to save a document as a web page. 
 
A. File, Save as Web Page 
B. File, Save Web Page 
C. Save, As Web Page 
D. File, Save, Web, Page 
 
Answer: A 
 
Explanation: Selecting File, Save as Web Page saves the document in HTML format so it 
can be published to the Internet. 

 
QUESTION 8: 
 
You are working on a ten-page document that contains a header. You want to change to a 
different header starting on page five. What type of break can you insert on the page so 
you can start a new header? 
 
A. Fragment 
B. Partition 
C. Section 
D. Sector 
 
Answer: C 
 
Explanation: Section breaks are used to divide a document so different headers and footers 
can be used throughout the sections. To insert a section break at the insertion point 
location, select Insert, Break on the menu bar. 

 
QUESTION 9: 
 
Tia creates an Organizational Chart diagram on her document. The chart will consist of 
managers and assistant managers. What shape will she use to represent the assistant 
managers in relation to the managers? 
 
A. Co-Worker 
B. Assistant 
C. Subordinate 
D. Co-Assistant 
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Answer: C 
 
Explanation: An organizational chart is a hierarchical structure which represents 
relationships between objects in an organization. Shapes (boxes. directly below other 
shapes are subordinate shapes. Assistant managers are subordinate to managers. Charts 
and diagrams are created by selecting Insert, Diagram on the menu bar. 

 
QUESTION 10: 
 
Which methods below can be used to apply newspaper columns to a document? Select all 
that apply. 
 
A. Insert, Columns on the menu bar 
B. Format, Columns on the menu bar 
C. Tools, Columns on the menu bar 
D. Columns button on the toolbar 
 
Answer: B, D 
 
Explanation:  
Newspaper columns can be applied to a document by selecting Format, Columns on the 
menu bar or by clicking the Columns toolbar button on the Standard toolbar. 

 
QUESTION 11: 
 
Select the correct menu bar sequence to apply shading to a paragraph. 
 
A. Format, Paragraph, Shading 
B. Paragraph, Borders and Shading 
C. Tools, Borders and Shading 
D. Format, Borders and Shading 
 
Answer: D 
 
Explanation: Shade a paragraph by selecting Format, Borders and Shading on the menu 
bar, and selecting the Shading tab. 

 
QUESTION 12: 
 
Which choice below is NOT a font style? 
 
A. Color 
B. Underline 
C. Bold 
D. Italic 
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Answer: A 
 
Explanation: The four font styles are bold, italic, bold-italic, and underline. Font styles can 
be applied either from the Formatting toolbar or by clicking Format, Font on the menu 
bar. 

 
QUESTION 13: 
 
Pick the correct menu bar sequence so gridlines do not show when a table is created. 
 
A. Table, Hide Gridlines 
B. Format, Hide Gridlines 
C. Hide Gridlines, Table 
D. Table, Gridlines 
 
Answer: A 
 
Explanation: Don't confuse gridlines with borders. This is a common mistake. Hide 
gridlines by selecting Table, Hide Gridlines on the menu bar 

 
QUESTION 14: 
 
Josh is working on his document which contains a five row table. The cell cursor is in row 3 
of the table. What menu bar sequence can he use to insert a row between rows 2 and 3? 
 
A. Insert, Table, Rows Above 
B. Table, Insert, Rows Below 
C. Table, Insert, Rows Above 
D. Insert, Row, Above 
 
Answer: C 
 
Explanation: When inserting rows, it is important to know the location of the cursor. 
Knowing where the cursor is determines what option you should select from the Table, 
Insert menu bar sequence. Insert Rows Above or Below is relative to location of the cursor 
location within the table. 

 
QUESTION 15: 
 
There is a picture file you wish to place into your document. What menu command 
sequence would you use to properly insert the picture? 
 
A. File, Insert, Picture 
B. Insert, Picture, From File 
C. Tools, Insert, Picture 
D. Insert, File, Picture 
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Answer: B 
 
Explanation: ClipArt, picture files, WordArt, and other graphic related objects can be 
inserted into a document by selecting Insert, Picture on the menu bar. The Drawing 
toolbar can also be used to insert graphic objects. 

 
QUESTION 16: 
 
Marcia is working on her Word outline. She has just finished keying third level text and 
has hit the enter key which has taken her to a new third level bulleted item. What key 
combination can she use to go back up one level in the outline? 
 
A. Ctrl-TAB 
B. TAB 
C. Alt-TAB 
D. Shift-TAB 
 
Answer: D 
 
Explanation: To go down levels in an outline, the TAB key is used. To go up outline levels, 
perform a SHIFT-TAB. To create an outline, click Format, Bullets and Numbering on the 
menu bar, and select the desired bulleted or numbered characters 

 
QUESTION 17: 
 
Pick the TRUE statements in reference to Print Previewing a document. Select all that 
apply. 
 
A. Turn it on from the File menu 
B. Multiple pages can be previewed 
C. Edit while in Print Preview mode 
D. You can't preview a blank document 
 
Answer: A, B, C 
 
Explanation: D is the only false answer. Although you may never do it, a blank document 
can be previewed. Preview a document by clicking File, Print Preview on the menu bar. 
Multiple pages can be previewed by selecting the Multiple Pages button from thePrint 
Preview toolbar. A document can be edited in Print Preview by clicking the Magnifier 
button on the Print Preview toolbar. 

 
QUESTION 18: 
 
What are some of the search options you can select when performing a Find and Replace? 
Select all that apply. 
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A. Match Case 
B. Use Wildcards 
C. Sounds Like 
D. Looks Like 
 
Answer: A, B, C 
 
Explanation: Looks Like is not an option. Other options include Find Whole Words Only 
and Find All Word Forms. 

 
QUESTION 19: 
 
Under what situation would you use Save As instead of Save? Select all that apply. 
 
A. Save to different location 
B. Saving for the first time 
C. Save file with same name 
D. Save in a different file format 
 
Answer: A, B, D 
 
Explanation: D is the only answer that doesn't require the Save As dialog box. Saving in a 
different file format such as Word 6.0 requires you do use the Save As dialog box as does a 
first time save and saving to a different location such as a floppy disk. 

 
QUESTION 20: 
 
Pick TWO options that would cause the Save As dialog box to appear on a document that 
has already been saved once. Select TWO answers. 
 
A. File, Save on the menu bar 
B. F12 key 
C. Tools, Save As on the menu bar 
D. File, Save As on the menu bar 
 
Answer: B, D 
 
Explanation: The Tools menu has no Save option. The F12 key is a less familiar method of 
calling up the Save As dialog box. 

 
QUESTION 21: 
 
When inserting a date field into a Word document, what check box must be checked in the 
Date and Time dialog box so the date and time changes automatically? 
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A. Update Automatically 
B. Update 
C. Change 
D. Change Automatically 
 
Answer: A 
 
Explanation: Placing a check mark in the Update Automatically check box when in the 
Date and Time dialog box will cause the date and time to update automatically. Select 
Insert, Date and Time on the menu bar to insert a date and time field. 

 
QUESTION 22: 
 
Which is NOT a line spacing option when formatting a paragraph from the Paragraph 
dialog box? 
 
A. 1.5 Lines 
B. Single 
C. At most 
D. Double 
 
Answer: C 
 
Explanation: A, B, and D are all line spacing options. There is no At Most option. There is, 
however, an At Least line spacing option. Set line spacing by selecting Format, Paragraph 
on the menu bar or by selecting the Line Spacing button on the Formatting toolbar. 

 
QUESTION 23: 
 
When comparing and merging document, how to the differences appear between the 
documents. 
 
A. Changes Tracked 
B. Tracked Changes 
C. Changes Updated 
D. Tracked Modifications 
 
Answer: B 
 
Explanation: When a document is compared and merged with another, the differences 
display as tracked changes. Select Tools, Compare and Merge Documents on the menu bar 
to compare and merge documents. 

 
QUESTION 24: 
 
Pick the improper method of bolding selected text. 
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A. Formatting toolbar button 
B. Ctrl-B 
C. Font Style in Font dialog box 
D. Standard toolbar button 
 
Answer: D 
 
Explanation: The Standard toolbar does not contain any formatting buttons. All font styles 
can be accessed by selecting Format, Font on the menu bar. 

 
QUESTION 25: 
 
Assuming the Formatting toolbar has not been altered from its default setting, which 
buttons are NOT on the toolbar. Select all that apply. 
 
A. UNDO 
B. Increase/Decrease Indent 
C. Small Caps 
D. Highlight 
 
Answer: A, C 
 
Explanation: UNDO is on the Standard toolbar not Formatting. The small caps text effect 
is most often applied from the Effects section of the Font dialog box. 

 
QUESTION 26: 
 
Pick all methods to start the spell checker. Select all that apply. 
 
A. F7 
B. Formatting toolbar button 
C. Tools, Spelling and Grammar 
D. Standard toolbar button 
 
Answer: A, C, D 
 
Explanation: There are three primary ways to start the spell checker: F7 on the keyboard, 
Tools, Spelling and Grammar on the menu bar, and selecting the Spelling and Grammar 
button on the Standard toolbar. Words not recognized by the spell checker are identified 
by a red, wavy line beneath the word. 

 
QUESTION 27: 
 
The font size of a character uses what unit of measure? 
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A. Points 
B. Pixels 
C. Millimeters 
D. Inches 
 
Answer: A 
 
Explanation: Fonts are measured in points. One point equals 1/72nd of an inch. Hence: A 
font size of 72 would print one inch on the page. Font size can be changed from the Font 
Size dropdown list on the Formatting toolbar. 

 
QUESTION 28: 
 
What would you key into the Pages field of the Print dialog box if you only want pages 1 
through 10 and page 18 to print? 
 
A. 1,10,18 
B. 1-10,18 
C. 1-18 
D. 1-10-18 
 
Answer: B 
 
Explanation: When printing separate or grouped pages, dashes indicate "through" and 
commas represent individual pages. Select File, Print on the menu bar or perform a Ctrl?P 
on the keyboard to call up the Print dialog box. 

 
QUESTION 29: 
 
Pick all illegal document filenames. Select all that apply. 
 
A. MyDocument.doc 
B. My*Document.doc 
C. MyDocument.dco 
D. My?Document.doc 
 
Answer: B, D 
 
Explanation: Be careful!! Although C looks incorrect, you can use any file extension you 
want. If a filename extension is different than DOC, Word will actually add DOC at the 
end. In answer C, Word would make it MyDocument.dco.doc which is still a legal but 
awkward looking filename. Asterisks and question marks are wildcard characters and 
cannot be used in a document filename. 

 
QUESTION 30: 
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Mia's paragraph is aligned evenly on both left and right sides of the paragraph. What type 
of justification is applied to Mia's paragraph? 
 
A. Right 
B. Full 
C. Left 
D. Justify 
 
Answer: D 
 
Explanation: Paragraph alignment where both sides are even is called justify. Newspapers 
and magazine articles typically use this type of justification. Setting paragraph alignment is 
most commonly done from the Formatting toolbar. 

 
QUESTION 31: 
 
word automatically corrects the spelling. What Word feature is working? 
 
A. AutoComplete 
B. AutoFix 
C. AutoSpell 
D. AutoCorrect 
 
Answer: D 
 
Explanation: AutoCorrect is a feature that automatically corrects commonly misspelled 
words. To add your own words to AutoCorrect, select Tools, AutoCorrect Options on the 
menu bar. Key the misspelled word into the Replace field followed by the correct spelling 
into the With field. 

 
QUESTION 32: 
 
Previewing a document as it will appear on the Internet uses which view. 
 
A. Web Page Preview 
B. View Web Page 
C. Web Page View 
D. age View 
 
Answer: A 
 
Explanation: Selecting File, Web Page Preview on the File menu displays the document in 
the Internet Explorer web browser. 

 
QUESTION 33: 
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Samantha has replaced the word Manager with the word Leader throughout her document 
using the Find and Replace feature. Upon inspection, she realizes that totally unrelated 
words like leadership have also been updated when they shouldn't have been. What option 
should Samantha have used when in the Find and Replace dialog box that would have 
avoided this situation? 
 
A. Use Wildcards 
B. Find All Word Forms 
C. Find Whole Words Only 
D. Match Case 
 
Answer: C 
 
Explanation: Although all answers are options in the dialog box, Find Whole Words Only 
is the correct answer. Selecting this option ensures that only the whole word is searched for 
and not parts of larger words like leadership. Select Edit, Replace on the menu bar to call 
up the Find and Replace dialog box. 

 
QUESTION 34: 
 
Assuming that all page setup settings have not been altered, what are the default top and 
bottom margins for a new blank document? 
 
A. 1.25" 
B. 2" 
C. 1.5" 
D. 1" 
 
Answer: D 
 
Explanation: The default top and bottom margins are 1" and the default right and left 
margins are 1.25". Margins are changed from the Margins tab in the Page Setup dialog 
box. 

 
QUESTION 35: 
 
Susan is print previewing her document and notices that a very small amount of text 
appears at the top of page 2. What toolbar button can Susan select in Print Preview so the 
text fits on one page? 
 
A. Scale to fit 
B. Size to fit 
C. Reduce to fit 
D. Shrink to fit 
 
Answer: D 
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Explanation: Shrink to fit slightly decreases the font size of the document text. This feature 
is usually used for short documents (2-3 pages.. 

 
QUESTION 36: 
 
A file with a filename extension of JPG, BMP, and GIF are what kind of file? 
 
A. Document Files 
B. Picture Files 
C. Web page files 
D. ClipArt Files 
 
Answer: B 
 
Explanation: Many picture file extensions are JPG, BMP, and GIF. Document files are 
DOC, Web pages are HTM, and ClipArt files are WMF. Insert a picture into a document 
by selecting Insert, Picture, From File on the menu bar. 

 
QUESTION 37: 
 
What keyboard shortcut can be used to activate Word's Thesaurus feature? 
 
A. F7 
B. Shift-F7 
C. Ctrl-F7 
D. Alt-F7 
 
Answer: B 
 
Explanation: F7 turns on the spell checker and Shift-F7 activates the thesaurus. The 
thesaurus is used to find synonyms and antonyms of selected words. Selecting Tools, 
Language, Thesaurus on the menu bar can also be used to call up the Thesaurus dialog 
box. 

 
QUESTION 38: 
 
Assuming all default settings are in place, what is the default font color setting for a new 
document? 
 
A. Red 
B. Black 
C. Automatic 
D. Blue 
 
Answer: C 
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Explanation: Although Black seems like a tempting choice, Automatic is the official default 
font color setting. Furthermore, Automatic isn't really a color, it is a setting, which was 
specified in the question. 

 
QUESTION 39: 
 
You have been assigned to create a very wide table storing employee work schedule 
information in a Word document. The entire table must fit on one page. Which Word page 
orientation option would be best for this document? 
 
A. Lengthwise 
B. Landscape 
C. Portrait 
D. Panoramic 
 
Answer: B 
 
Explanation: Landscape orientation is the ideal page orientation for wide documents. Page 
orientation is selected from the Margins tab in the Page Setup dialog box. 

 
QUESTION 40: 
 
What is the maximum number of columns that can be applied from the Presets section of 
the Columns dialog box? 
 
A. 1 
B. 2 
C. 3 
D. 4 
 
Answer: C 
 
Explanation: Although up to 12 columns can be applied using the Number of columns field 
in the Columns dialog box, 3 is the highest number in the Presets section. Select Format, 
Columns on the menu bar to create, modify, and format columns. 

 
QUESTION 41: 
 
Select the incorrect keyboard shortcuts in reference to cutting, copying, and pasting data. 
Select all that apply. 
 
A. Ctrl-C = Cut 
B. Ctrl-V = Paste 
C. Ctrl-C = Copy 
D. Ctrl-P = Paste 
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Answer: A, D 
 
Explanation: Ctrl-X is used to cut data and Ctrl-P calls up the Print dialog box. 

 
QUESTION 42: 
 
Pick the TRUE statements in reference to Word comments. Select TWO answers. 
 
A. They appear in the right margin 
B. They appear in the left margin 
C. Inserted from the Insert menu 
D. They cannot be edited 
 
Answer: A, C 
 
Explanation: Comments appear in the right margin and are created by selecting Insert, 
Comment on the menu bar. Comments are inserted at the insertion point. 

 
QUESTION 43: 
 
Which dialog box can be used to create an outline in a Word document? 
 
A. Bullets and Numbering 
B. Font 
C. Numbering and Bullets 
D. Paragraph 
 
Answer: A 
 
Explanation: An outline can be created by selecting Format, Bullets and Numbering on the 
menu bar. 

 
QUESTION 44: 
 
Kelly wants to save her already saved document using the same name. Select all options she 
can use to save the file. Select all that apply. 
 
A. File, Save on the menu bar 
B. Ctrl-S 
C. Save toolbar button 
D. Tools, Save on the menu bar 
 
Answer: A, B, C 
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Explanation: There is no Save command on the Tools menu. All other answers can be used 
to save a previously saved document. 

 
QUESTION 45: 
 
When shading a paragraph, what button can be selected on the Shading panel within the 
Borders and Shading dialog box to create Custom colors? 
 
A. Additional Colors 
B. More Colors 
C. Normal Colors 
D. Custom Colors 
 
Answer: B 
 
Explanation: Custom colors can be created by selecting the More Colors button on the 
Shading panel of the Borders and Shading dialog box. 

 
QUESTION 46: 
 
Don begins to key "To Whom It May Concern" but while but half way through, a small 
yellow box appears by the insertion point displaying the whole phrase "To Whom It May 
Concern". What Word feature is working? 
 
A. AutoText 
B. AutoFill 
C. AutoWord 
D. AutoComplete 
 
Answer: A 
 
Explanation: AutoText has a complete library of commonly used business words. Examples 
include Ladies and Gentlemen, and Attention. Select Insert, AutoText on the menu bar to 
see many more AutoText entries. 

 
QUESTION 47: 
 
Erica inserts default page numbering into her document. How will the number appear on 
page 1? 
 
A. 1 
B. i 
C. I 
D. A 
 
Answer: A 
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Explanation: By default, page numbers are Arabic. Page number formats can be changed 
by selecting View, Header and Footer on the menu bar and selecting the Format Page 
Number button on the Header and Footer toolbar. 

 
QUESTION 48: 
 
Which one below is NOT a section break type? 
 
A. Odd 
B. Previous Page 
C. Even 
D. Continuous 
 
Answer: B 
 
Explanation: The four section break types are: Continuous, Odd, Even, and Next Page. 
Breaks are inserted from the Insert menu. 

 
QUESTION 49: 
 
Connecting two or more cells in a table is called ______________ and dividing one cell into 
two or more separate cells is called ______________. Select TWO answers. 
 
A. Splitting 
B. Joining 
C. Breaking 
D. Merging 
 
Answer: A, D 
 
Explanation: Breaking up a cell into two or more cells is called splitting and joining two or 
more cells into one cell is called merging. Both operations are completed by selecting the 
cell(s. and selecting the desired option from the Table menu. 

 
QUESTION 50: 
 
Emboss, Engrave, Outline, and Shadow are examples of what? 
 
A. Text Properties 
B. Text Effects 
C. Text Characteristics 
D. Character Effects 
 
Answer: B 
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Explanation: Text effects are applied by selecting the desired effect from the Effects section 
in the Font dialog box. 

 
QUESTION 51: 
 
Pick the correct menu bar sequence so gridlines do not show when a table is created. 
 
A. Table, Hide Gridlines 
B. Format, Hide Gridlines 
C. Hide Gridlines, Table 
D. Table, Gridlines 
 
Answer: A 
 
Explanation: Don't confuse gridlines with borders. This is a common mistake. Hide 
gridlines by selecting Table, Hide Gridlines on the menu bar 

 
QUESTION 52: 
 
What is the quickest way to apply newspaper columns to the current document? 
 
A. Standard toolbar button 
B. Format, Columns on the menu bar 
C. File, Columns on the menu bar 
D. Formatting toolbar button 
 
Answer: A 
 
Explanation: A and B can be used to apply newspaper columns but answer A would be the 
quickest method. 

 
QUESTION 53: 
 
Gayle has copied data from an Excel spreadsheet. The data will be inserted into a Word 
document. She wants the numbers to update in her document if the spreadsheet numbers 
change. What menu bar paste method will she use to successfully accomplish this task? 
 
A. Edit, Paste 
B. Edit, Paste Special 
C. Edit, Paste Spreadsheet 
D. Edit, Paste Link 
 
Answer: A 
 
Explanation:  
She will select Edit, Paste Special on the menu bar. When the Paste Special dialog box 
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opens, she will select the Microsoft Excel Worksheet Object from the As list window and 
she will select the Paste Link option button. Selecting the Paste Link button will link her 
spreadsheet data to the document and any updates made in Excel will reflect in the 
document. 

 
QUESTION 54: 
 
Which tab stop below is NOT available in a Word document? 
 
A. Top 
B. Decimal 
C. Left 
D. Center 
 
Answer: A 
 
Explanation: The top tab does not exist in Word. To set tabs, select Format, Tabs on the 
menu bar or select the tab from the tab selector on the ruler and click each tab location on 
the ruler. Decimal tabs keep the decimal point in line when a column of decimal numbers 
are keyed. Center tabs are used to center data in a column. Left tabs keep data left aligned 
when keyed in a column. 

 
QUESTION 55: 
 
The highlight button is located on the _______________ toolbar. 
 
A. Picture 
B. Standard 
C. Drawing 
D. Formatting 
 
Answer: D 
 
Explanation: Assuming an unaltered toolbar, the highlight button is the next to last button 
on the Formatting toolbar. 

 
QUESTION 56: 
 
Folders can be created from which TWO dialog boxes? Select TWO answers. 
 
A. Save As 
B. Print 
C. Properties 
D. Open 
 
Answer: A, D 
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Explanation: The Save As and Open dialog boxes can be used to create folders. These 
dialog boxes contain a Create New Folder button on the dialog box's toolbar. Folders are 
storage locations for individual files. Folders in Windows resemble manila folders found in 
a file cabinet. 

 
QUESTION 57: 
 
Pick the methods below to indent a paragraph. Select all that apply. 
 
A. Paragraph dialog box 
B. Standard toolbar 
C. Ruler indent markers 
D. Indent dialog box 
 
Answer: A, C 
 
Explanation: The indent dialog box does not exist nor can indents be applied from the 
Standard toolbar. Indenting can be applied by selecting Format, Paragraph on the menu 
bar or by clicking and dragging the indent markers on the ruler. 

 
QUESTION 58: 
 
When a Word document is saved as a web page, it is saved in ___________________ 
format. 
 
A. HMTL 
B. HTLM 
C. HMLT 
D. HTML 
 
Answer: D 
 
Explanation: HTML, or Hypertext Markup Language is the file format used for web pages 
on the Internet. 

 
QUESTION 59: 
 
Pick the incorrect keyboard shortcut when aligning paragraph text. 
 
A. Ctrl-R - Right Align 
B. Ctrl-E - Center Align 
C. Ctrl-C - Center Align 
D. Ctrl-L - Left Align 
 
Answer: C 
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Explanation: Tricky question here. Remember, Ctrl-C copies selected data to the 
clipboard. 

 
QUESTION 60: 
 
When inserting a date field code from the Date and Time dialog box, what is the default 
(top. date format? 
 
A. February 10, 2003 
B. 2-10-03 
C. 2/10/2003 
D. 10-Feb-03 
 
Answer: C 
 
Explanation: All of these formats are available but C is the default format. Insert the Date 
and Time field by selecting Insert, Date and Time on the menu bar. 

 
QUESTION 61: 
 
David has selected the word "fantastic" in his document. For what reason would he use 
Word's Thesaurus feature? 
 
A. Check spelling 
B. Check grammar 
C. Change languages 
D. Find synonyms and antonyms 
 
Answer: D 
 
Explanation: The thesaurus is used to find synonyms and antonyms for selected words. The 
thesaurus is turned on by selecting Tools, Language, Thesaurus on the menu bar. 

 
QUESTION 62: 
 
How many cut/copied items can be stored on the clipboard? 
 
A. 1 
B. 12 
C. 6 
D. 24 
 
Answer: D 
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Explanation: MS Office 2000's clipboard can store 12 cut/copied items and MS Office 97 
can hold only one. 

 
QUESTION 63: 
 
First Line and Hanging are what type of paragraph indents? 
 
A. Proprietary 
B. Standard 
C. Special 
D. Unique 
 
Answer: C 
 
Explanation: First Line and Hanging indents are applied from the Special dropdown list in 
the Paragraph dialog box. 

 
QUESTION 64: 
 
Previewing a document as it will appear on the Internet uses which view. 
 
A. Web Page Preview 
B. View Web Page 
C. Web Page View 
D. age View 
 
Answer: A 
 
Explanation: Selecting File, Web Page Preview on the File menu displays the document in 
the Internet Explorer web browser. 

 
QUESTION 65: 
 
Marla saves a blank weekly timesheet as a template so employees can open it, fill it out, 
then save it under a different name. What filename extension is applied to the document 
template by default? 
 
A. DOT 
B. TMP 
C. TEM 
D. DOC 
 
Answer: A 
 
Explanation: To save a document as a template, activate the Save As dialog box and select 
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Document Template from the Save as type dropdown list. The DOT filename extension will 
automatically be appended to the filename. 

 
QUESTION 66: 
 
Which button does not appear on the Header and Footer toolbar? 
 
A. Format Page Number 
B. Insert Time 
C. Alignment 
D. Insert Date 
 
Answer: C 
 
Explanation: Alignment buttons do not appear on the Header and Footer toolbar. They are 
located on the Formatting toolbar. Insert a header and footer by selecting View, Header 
and Footer on the menu bar. 

 
QUESTION 67: 
 
Which is NOT a method of aligning paragraph text? Select all that apply. 
 
A. Ctrl-C 
B. Font Dialog Box 
C. Ctrl-E 
D. Ctrl-R 
 
Answer: A, B 
 
Explanation: Ctrl-C copies selected data to the clipboard and the Font dialog box does 
contain paragraph alignment options. Ctrl-R right aligns text and Ctrl-E center aligns text. 

 
QUESTION 68: 
 
Assuming there is an unaltered installation of Microsoft Word with all default settings in 
place, what is the default font and font size of a new blank document? 
 
A. Arial, 12 pt 
B. Times New Roman, 10 pt 
C. Times New Roman, 12 pt 
D. Arial, 10 pt 
 
Answer: C 
 
Explanation: The default font and font size is 12 point times new roman. This default can 
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be changed for all documents by setting the font in the Font dialog box and clicking the 
Default button. 

 
QUESTION 69: 
 
Shimmer and Sparkle Text are examples of ____________________. 
 
A. Text Properties 
B. Text Effects 
C. Text Attributes 
D. Text Settings 
 
Answer: B 
 
Explanation: Shimmer and Sparkle Text are examples of Text Effects. Other effects 
include Shimmer and Marching Black Ants. Text effects are applied from the Text Effects 
tab in the Font dialog box. 

 
QUESTION 70: 
 
When menu bar sequence can Mark use to create mailing labels? 
 
A. Tools, Envelopes and Labels 
B. Tools, Letters and Mailings, Envelopes and Labels 
C. Format, Envelopes and Labels 
D. Tools, Mailings, Envelopes 
 
Answer: B 
 
Explanation: Select Tools, Mailings, Envelopes and Labels on the menu bar to create 
envelopes and labels. Answer A was used in previous versions of Word. 

 
QUESTION 71: 
 
Select the TRUE statements in reference to paragraph formatting. Select all that apply. 
 
A. Hanging indents can be used 
B. Line spacing is single by default 
C. Ctrl-E right aligns a paragraph 
D. Before and After is a spacing option 
 
Answer: A, B, D 
 
Explanation: All answers are correct except C. Ctrl-E center aligns a paragraph. 
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QUESTION 72: 
 
John has a ten-page document that contains two sections with different headers. He decides 
to remove the header from the second section and connect to the header in the first section. 
After he deletes the header in section 2, what button can he click on the Header and Footer 
toolbar to connect to the header in section 1? 
 
A. Same as Previous 
B. Same as Next 
C. Previous Section 
D. Same as Prior 
 
Answer: A 
 
Explanation: Clicking the Same as Previous button on the Header and Footer toolbar will 
link the section 1 header to section 2. 

 
QUESTION 73: 
 
Erica inserts default page numbering into her document. How will the number appear on 
page 1? 
 
A. 1 
B. i 
C. I 
D. A 
 
Answer: A 
 
Explanation: By default, page numbers are Arabic. Page number formats can be changed 
by selecting View, Header and Footer on the menu bar and selecting the Format Page 
Number button on the Header and Footer toolbar. 

 
QUESTION 74: 
 
Thomas has a six-page report with headings at every paragraph. What is the most efficient 
way he can format and reformat his headings without having to format each individual 
heading every time? 
 
A. Don't use headings 
B. Apply a style to the headings 
C. Use the format painter 
D. Change the format manually 
 
Answer: B 
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Explanation: Although the format painter would be fairly quick, applying styles is the best 
answer because if Thomas modifies the style, the style formatting will automatically update 
throughout the headings. Styles are created and applied by selecting Format, Style on the 
menu bar and selecting the desired style from the task pane. 

 
QUESTION 75: 
 
Which option is selected from the New Document task pane to view and select document 
templates without using the Internet? 
 
A. All Templates 
B. General Templates 
C. Template Sets 
D. Standard Templates 
 
Answer: B 
 
Explanation: Selecting File, New on the menu bar, causes the task pane to display. Clicking 
the General Templates option in the task pane displays the Templates dialog box where 
you can select letter, memo, and fax templates. 

 
QUESTION 76: 
 
Assuming that all initial default settings are in place, what is the default tab stop in a new 
blank document? 
 
A. No tabs are set 
B. Every Half Inch 
C. Every Quarter Inch 
D. Every Inch 
 
Answer: B 
 
Explanation:  
Although they don't appear on the ruler, there are tabs every half-inch in a blank 
document. Once a tab is set either from the Ruler or Tabs dialog box, all default tabs are 
cleared. The default tab stops can be changed from the Default tab stops field in the Tabs 
dialog box. 

 
QUESTION 77: 
 
Which button is selected on the Headers and Footers toolbar to change existing page 
numbers to roman numerals? 
 
A. Format Page Number 
B. Page Number Format 
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C. Page Number Properties 
D. Number Format 
 
Answer: B 
 
Explanation: Clicking the Page Number Format button on the Headers and Footers 
toolbar allows you to change how your page numbering looks. Page numbers can be 
numbers, letters, lowercase roman numerals, and uppercase roman numerals. Page 
numbers can even start on numbers other than 1. 

 
QUESTION 78: 
 
Pick the FALSE statements in reference to bullets and numbering. Select TWO answers. 
 
A. Numbers can only start on 1 
B. TAB takes cursor down one level 
C. No toolbar buttons 
D. Shift-TAB takes cursor up one level 
 
Answer: A, C 
 
Explanation: The key to this type of question is to isolate the TRUE answers. In this case, B 
and D are true. There are toolbar buttons for bullets and numbering and numbers can 
start on numbers other than 1. 

 
QUESTION 79: 
 
Kyle is working on a ten-page document that is part of a larger document. His ten pages 
will be pages 21 through 30 in the larger document. What can he do to make sure the page 
numbers are proper when he is in the Page Number Format dialog box? 
 
A. Key 21 into the Start at field 
B. Key 30 into the Start at field 
C. Key 21 into the Begin page field 
D. Key 21 into the Number field 
 
Answer: A 
 
Explanation: To insert page numbers starting on a page other than 1, click Insert, Page 
Numbers on the menu bar. Select the Format button. Key the starting page number into 
the Start at field of the Page Number Format dialog box. 

 
QUESTION 80: 
 
Select the incorrect methods of inserting WordArt into a document. Select TWO answers. 
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A. Formatting toolbar button 
B. Drawing toolbar button 
C. Insert, WordArt on the menu bar 
D. Insert, Picture, WordArt on menu 
 
Answer: A, C 
 
Explanation: Although selecting Insert, Picture, WordArt can be used to insert WordArt, 
the Drawing toolbar button is much easier. 

 
QUESTION 81: 
 
What is the correct menu bar sequence to apply an AutoFormat to an existing table? 
 
A. Table, AutoFormat 
B. Table, Table AutoFormat 
C. Format, AutoFormat 
D. Format, Table AutoFormat 
 
Answer: B 
 
Explanation: Answer A looks tempting but the correct sequence is Table, Table 
AutoFormat on the menu bar. Table Classic 1 and Table Classic 2 are examples of table 
auto formats. 

 
QUESTION 82: 
 
Pick the FALSE statements in reference to saving a Word document. Select all that apply. 
 
A. 1st time saves require Save As dialog box 
B. Filenames can contain * and ? characters 
C. Spaces cannot be used 
D. Save As accessed from File menu 
 
Answer: B, C 
 
Explanation: Spaces can be used in a filename and saving a document for the first time 
requires the use of the Save As dialog box. Asterisks and question marks can never be used 
in a filename. These are wildcard characters. 


